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IP Office Embedded Voicemail:

1. IP Office Embedded Voicemail

For IP Office Release 8.0, embedded voicemail is supported by IP Office 500 and IP500v2 control units. Embedded
voicemail provides basic voicemail mailbox operation and auto-attendant operation without requiring a separate voicemail
server PC.

Embedded Voicemail uses the following components:

¢ Memory Card
The type of memory card used depends on the type of IP Office control unit. However, in all cases, the cards are
specially formatted by Avaya. Alternate third-party memory cards are not supported for Embedded Voicemail.

o IP Office 500 Control Units
These controls units require an optional Avaya Compact Flash memory card to be installed in order to use
embedded voicemail.

+ IP500v2 Control Units
This type of control unit uses the mandatory System SD card installed in all IP500v2 systems for embedded
voicemail if required.

« IP Office Manager Application
Embedded Voicemail is configured using options in the IP Office configuration using the IP Office Manager
application.

Notes
e Other Voicemail Servers
Embedded Voicemail cannot be used in conjunction with another voicemail server, for example IP Office Voicemail
Pro server. The presence of another voicemail server on the same network can cause Embedded Voicemail to fail to
operate correctly and vice versa.

o IP Office Basic Edition PARTNER Mode and IP Office Basic Edition NORSTAR Mode
This guide is for embedded voicemail on IP Office in IP Office Essential Edition mode. It does not cover IP Office
Basic Edition PARTNER Mode, IP Office Basic Edition NORSTAR Mode or IP Office Basic Edition Quick Mode.
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1.1 Mailbox Features

The IP Office system automatically creates an embedded voicemail mailbox for every user and hunt group in the IP Office
configuration.

For users, the mailbox is automatically used to answer calls to the user that ring unanswered for the user's configured No
Answer Time. The mailbox is also used in other situations where the IP Office would have otherwise returned busy tone,
for example when the user is set to Do Not Disturb.

For hunt groups, the mailbox is used when a call has rung for the group's Voicemail Answer Time.

o For security, a voicemail access code can be assigned to any mailbox. This can be changed by the mailbox user or
the system administrator.

e For user mailboxes, message waiting indication is provided to the user's IP Office phone extension and to their IP
Office user application (Phone Manager or one-X Portal).

e For hunt group mailboxes, message waiting indication can be assigned to specified users.

e Various dialling short codes[ 5% can be used to control voicemail features and for actions such as collecting
messages, leaving messages, turning voicemail on/off.

Embedded Voicemail System Comparison

m IP500 Control Units IP500v2 Control Unit

Memory Type 512MB Compact Flash. 4GB SDHC Card
Compression Method Uses G711. VCM not required. Uses G711. VCM not required.
Storage 15 Hours. 25 Hours.

15 Hours by default. An additional 5 hours is
added for each 2 additional channels licensed

below.

Maximum Simultaneous 4 Channels. 6 Channels maximum.

Connections Not adjustable. 2 Channels by default. Additional channels
require licenses.

Maximum Individual Default 120 seconds. Default 120 seconds.

Message Length Adjustable between 3 and 180 seconds. Adjustable between 3 and 180 seconds.

Auto Attendant Yes Yes

Embedded Voicemail Installation Page 8
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IP Office Embedded Voicemail: Mailbox Features

1.2 What's New

What's New in IP Office Release 8.0
For Avaya IP Office Release 8, system administrators can select the operating mode for voicemail. The operating mode
determines the features available, and also determines the commands used to access each feature.

The options for the operating mode are:

o IP Office mode
This mode provides the same functionality that was supported in previous releases.

e Intuity mode
This mode, which is available on IP500v2 systems, provides additional voicemail features.

For information about the supported features and how to access them, see the Embedded Voicemail User Guide for each
operating mode.
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1.3 Languages Supported

Embedded Voicemail supports a range of language prompt sets. The following languages are supported for Embedded

Voicemail.

Language

Arabic (ara)

IP Office mode Intuity mode

L

.

Chinese-Cantonese (zhh)

Chinese-Mandarin (chs)

Danish (dan)

Dutch (nid)

English UK (eng)

English US (enu)

Finnish (fin)

French (fra)

French-Canadian (frc)

German (deu)

Italian (ita)

Korean (kor)

Norwegian (nor)

Portugese (ptg)

Portuguese-Brazilian (ptb)

Russian (rus)

Spanish (esp)

Spanish-Argentina (ess)

Spanish-Mexico (esm)

Swedish (sve)

LG h] & & S & &) &) A &S]S A RS S A A

LA S S S S S &S]S S S S S &S S 5%

The IP Office system Locale setting is used to determine the default language prompts used. A Locale setting is set for the
whole IP Office system. For individual users and incoming call routes the system local can be overridden.

For calls to voicemail, the locale used is determined as follows:

e The user locale, if set, is used if the caller is internal.

e The incoming call route locale, if set, is used if caller is external.

e If no user or incoming call route locale is applicable, the system locale is used.

e A short code locale, if set, is used and overrides the options above if the call is routed to voicemail using the

short code.
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IP Office Embedded Voicemail: Languages Supported

Fallback languages
If a selected Locale is not supported, embedded voicemail uses a fallback language. The fallback language is used
depends on the configuration mode used by the IP Office server (Essential, Partner, Quick, or Norstar).

If your voicemail configuration requires a locale that has not been downloaded to the IP Office server, a warning message
displays to indicate which locale is missing. If you do not add the locales, Manager will use the fallback languages listed in
the table below.

Locale selected in Manager Fallback Languages in

Essential / Norstar

Fallback Languages in
Quick and Partner
configuration modes

configuration mode

Arabic (ara)

eng > enu

enu > eng

Argentina (ess)

esp > eng > enu

esp > enu > eng

Bahrain (arh)

ara > eng > enu

ara > enu > eng

Belgium-French (frb)

fra > frc > eng

fra > frc > enu

Belgium-Dutch (nib)

nld > eng > enu

nld > enu > eng

Brazilian Portuguese (ptb)

pt > eng > enu

pt > enu > eng

Chile (esl)

esm > esp > enu

esm > esp > enu

Chinese-Cantonese (zzh)

eng > enu

enu > eng

Chinese—-Madarin (chs)

eng > enu

enu > eng

Colombia (eso)

esm > esp > enu

esm > esp > enu

Danish (dan)

eng > enu

enu > eng

Dutch (nid)

eng > enu

enu > eng

Egypt (are)

ara > eng > enu

ara > enu > eng

English UK (eng) enu enu
English US (enu) eng eng
Finnish (fin) eng > enu enu > eng

French (fra)

frc > eng > enu

frc > enu > eng

French Canadian (frc)

fra > enu > eng

fra > enu > eng

German (deu) eng > enu enu > eng
Italian (ita) eng > enu enu > eng
Korean (kor) eng > enu enu > eng

Kuwait (ark)

ara > eng > enu

ara > enu > eng

Latin Spanish (esm)

esp > enu > eng

esp > enu > eng

Morocco-French (arm)

fra > frc > eng

fra > frc > enu

Norwegian (nor)

eng > enu

enu > eng

Oman (aro)

ara > eng > enu

ara > enu > eng

Peru (esr)

esm > esp > enu

esm > esp > enu

Polish (pl)

eng > enu >

enu > eng

Portuguese (ptg)

ptb > eng > enu

ptb > enu > eng

Qatar (arq)

ara > eng > enu

ara > enu > eng

Russian (rus)

eng > enu >

enu > eng

Spanish (esp)

esm > eng > enu

esm > enu > eng

Swedish (sve)

eng > enu

enu > eng

Switzerland-French (frs)

eng

enu

Switzerland-German (des)

deu > eng > enu

deu > enu > eng

Switzerland-Italian (its)

ita > eng > enu

ita > enu > eng

Taiwan (cht)

chs > eng> enu

chs > eng> enu

Venezuela (esv)

esm > esp > enu

esm > esp > enu
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2. Installing Embedded Voicemail

The installation process can be divided into the following steps:

1.Embedded Voicemail Installation
The physical installation of the memory card. This process varies according to the IP Office control unit type.

o IP500 Control Unit/ 15"

¢ IP500v2 Control Unit
No hardware installation is needed for IP500v2 control units as they use the already installed mandatory
System SD card for embedded voicemail.

2.Upgrade Prompts/[ 16"
A set of prompts are provided on Embedded Voicemail memory cards supplied by Avaya. If you need prompts that
are not provided on your existing card, you can add any additional prompts that are required for new features.

3.Enable Embedded Voicemail [ 17
Set the IP Office to use Embedded Voicemail and set the maximum record time for messages, greetings and
prompts.

4.User Mailbox Configuration /23
Configure the personal settings for individual users.

5. Hunt Group Mailbox Configuration| 28"
Configure the settings for any hunt groups where voicemail is required. This includes configuring message waiting
indication and mailbox access which are not enabled by default.

6.Auto Attendant Configuration/3#
Setup any required auto-attendant services and associate them with incoming call routes.
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Installing Embedded Voicemail:

2.1 IP500 Installation

The following instructions detail the process for installing Embedded Voicemail for an IP500 system.

1. Check that the following requirements have been met.
¢ Hardware:
o IP Office control unit.
e Avaya supplied Embedded Voicemail Memory Card (512MB Compact Flash).
o IP Office Administrator Applications CD matching the software release of the IP Office system.
o Configuration:
e PC, connected to the IP Office network with the IP Office Manager application installed.

2.Install the Memory Expansion Card
The memory card is a Type II Compact Flash memory card. Only a card supplied by Avaya can be used for
embedded voicemail. Compact Flash cards from other sources cannot be used for embedded voicemail.

e Insert the memory card into the C/F TII card slot. Insert the card with the memory card label upwards.

3.Upgrade the Prompts/ 163

The prompts on the Embedded Voicemail memory card can now be upgraded to match the software level of the IP
Office.

4.Enable Embedded Voicemail[ 1%
For new and defaulted systems embedded voicemail is enabled by default.

2.2 IP500v2 Installation

The following instructions detail the process for installing Embedded Voicemail for an IP500 system.

1.Upgrade the Prompts/ 16}

The prompts on the Embedded Voicemail memory card can now be upgraded to match the software level of the IP
Office.

2.Enable Embedded Voicemail[ 17
For new and defaulted systems embedded voicemail is enabled by default.

3.Add Embedded Voicemail Licenses

If more that 2 channels are required, the licenses for the additional channels up to a total of 6 channels should be
added.
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2.3 Upgrading Prompts

Embedded voicemail memory cards are normally supplied with the prompt files pre-installed.

When you install a new System SD card in IP Office 500v2 systems, or upgrade an existing card, a default set of
languages is loaded on the card. You can use the Add/Display VM Locales button on the System > Voicemail tab to
select additional language prompt sets to upload. For example, when you upgrade to a new release of IP Office, it is
possible that new features require additional prompts. Click the button to launch a list of available languages. Languages
that are already on the card are greyed-out.

The Add/Display VM Locales button displays on active systems only, and is not available for offline configuration. This
button displays only when you select Embedded Voicemail as the Voicemail Type.

You can also reload languages that are already installed on the System SD card. For example, you can reload languages if
new prompts have been added in a maintenance release. To reload the existing languages, upgrade the system (File |
Advanced | Upgrade) with Upload System Files option checked. You can also choose Upload System Files from the
Embedded File Management utility (File | Advanced | Embedded File Management).

All the prompts for Embedded Voicemail are found in the LVMSound folder in the installation package for IP Office
Administrator Applications.

Checking the Prompt Sets

The additional embedded voicemail features added in new IP Office releases require new prompts. Missing prompts can be
reported in IP Office System Monitor by enabling the trace options Filters | System | Error. Error messages are output
at regular intervals.

158267586mS ERR: EVM 4p0 upgrade file clips missing
158267587mS ERR: EVM 4p2 upgrade file clips missing
158267592mS ERR: EVM 5p0 upgrade file clips missing

Transferring the Prompt Files Using IP Office Manager
1. Start IP Office Manager.

2.Select File | Advanced | Embedded File Management.
3.Use the Select IP Office menu to select the required IP Office system.
4.The next step will depend on the type of IP Office control unit:

+ IP500 Control Units
Select File | Upload Voicemail Prompts. This will transfer the prompt files installed with IP Office Manager to
the memory card.

e IP500v2 Control Units
Select File | Upload System Files. This will transfer the the prompts files installed with IP Office Manager and
the IP Office firmware files. Do not do this if the level of IP Office Manager software is not appropriate for the
IP Office system.

Embedded Voicemail Installation Page 16
IP Office Release 8.0 15-601067 Issue 12d (21 February 2012)



Installing Embedded Voicemail: Upgrading Prompts

2.4 Enabling Embedded Voicemail

The system configuration for embedded voicemail is common to all the IP Office systems that support it. This option is
enabled by default and needs to be disabled if not using embedded voicemail.

In IP500v2 systems, you can choose whether embedded voicemail operates in IP Office mode or in Intuity mode. In new
installations of embedded voicemail in Partner, Norstar, or Quick modes, the default operating mode for voicemail is
Intuity mode. For new installations of embedded voicemail in Essential Edition mode, the default operating mode for
voicemail is IP Office mode. You can switch between modes without losing user data, such as passwords, greetings, or
messages.

To configure an IP Office for Embedded Voicemail:

1.This process requires the IP Office system to be rebooted to complete the process. That will end all current calls and
operation for a period of up to 5 minutes.

2.0pen IP Office Manager and receive the IP Office configuration.

.Select = =/ System.
.Click the Voicemail tab.
.From the Voicemail Type list, select Embedded Voicemail.

.From the Voicemail Mode list, select either IP Office Mode or Intuity Mode.

N oo o1 AW

.Set the Maximum Record Time for messages and prompts to the value required by the customer. The allowable
range is 30 to 180 seconds with 110 seconds as default.

8.View the System tab.

¢ The Locale setting should match the language for spoken prompts required from the Embedded Voicemail. When
you configure embedded voicemail, the prompts and tones used by the voicemail system are determined by the
locale setting. When the IP Office system routes a call to voicemail, it indicates the locale so that prompts are
available based on the languages associated with that locale. The system indicates the locale to the voicemail
server based on the following settings:

e short codes related to voicemail, auto attendant, and record message features (User | ShortCodes) and
(UserRights | ShortCodes)

e the incoming call route when the destination is set to voicemail or auto-attendant (Incoming Call Route |
Standard | Locale)

e user settings for internal calls (User | User | Locale)
e the system locale is used by voicemail if no user or incoming call route is set (System | System | Locale)

A set of default locales are available on the IP Office server. The locales that are available by default depend on
the configuration mode that you are using. If your voicemail configuration requires a locale that has not been
downloaded to the IP Office server, a warning message displays to indicate which locale is missing. Click the
warning to open a window and follow the prompts to add the locales. You can also download the locales from the
System menu (System | Voicemail) or from the File menu (File | Advanced). If you do not add the locales,
embedded voicemail will use the fall back locale; for more information, see Lanquages Supported /[ 14,

9.Click OK to save the voicemail system changes.

10.Click L'E‘ to send the configuration change back to the control unit.

11.0nce the IP Office system has restarted, from an extension on the system dial *17. The embedded voicemail
should answer and start to give you prompts.
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2.5 Removing Memory Cards

The memory card should never be removed from the system during normal IP Office operation. Doing so can cause the
corruption of files in use. Either the memory card or the whole IP Office system must be shutdown before removing a
memory card.

Whilst the card is shutdown, voicemail is not available to the IP Office system. Any other services that use the memory
card will also be disabled. For IP500v2 systems, features licensed by the card will continue for up to 2 hours while the card
is not present.

Once a memory card has been removed, reinserting the memory card will restart it.

Memory Card Shutdown Using IP Office Manager
1.In IP Office Manager, select Start | Advanced | Memory Card Command | Shutdown. For IP500v2 systems
select the System SD card.

2.Check that the LED for the memory card slot has been extinguished. The card can now be removed.

3.To restart the card without removing and reinserting it, select Start | Advanced | Memory Card Command |
Startup.

Memory Card Shutdown Using the IP Office System Status Application
1.In System Status, select System | Memory Cards. For IP500v2 systems select the System SD card.

2.Select Shutdown.
3. Check that the LED for the memory card skit has been extinguished. The card can now be removed.

4.To restart the card without removing and reinserting it, select Startup.
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3. User Mailbox Configuration

Embedded Voicemail creates a mailbox for each user on the IP Office system. Calls are routed to the mailbox whenever
the user's extension is busy or does not answer within the users allocated no answer time. This includes calls that are
forwarded to another internal destination.

An individual user's mailbox can be configured either through the mailbox and system short codes (refer to the Embedded
Voicemail User Guide) or by configuring the user settings in the IP Office Manager.

¢ Message Waiting Indication
If supported by the user's current phone, the user will receive message waiting indication whenever their mailbox
contains new messages. The type of message waiting indication will depend on the telephone.

e Mailbox Access
The standard default short code (*17) can be used to access an extensions associated user mailbox. Other
methods of mailbox access can be configured.

e For IP Office 4.2+, the MESSAGES button on phones, which normally emulates *17, can be configured to
access Visual Voice mode on phones that can support Visual Voice[ 493, This is done using the Messages
Button Goes To Visual Voice (System | Voicemail) option.

¢ Ringback
Embedded Voicemail can be set to ring the user whenever they have new messages in their mailbox. This ringback
is triggered the completion of a call at the user's extension. Ringback from a hunt group mailbox containing new
messages can also occur if the user is configured to receive hunt group message waiting indication.

¢ Voicemail On/Off
The sending of calls to the user's mailbox can be switched off. Note however that this does not stop other methods
of leaving messages directly in the user's mailbox.

¢ Access Code
An access code can be assigned to the mailbox. Anyone accessing the mailbox must first enter this code, before
they can collect messages. The access code can be reset by the user once they are in their mailbox.

¢ Voicemail Reception & Breakout Numbers
Setting a Voicemail Reception number for a user, allows callers leaving a message in their mailbox to dial *0 to be
transferred to that number. If used this feature should be announced in the mailbox greeting prompt. Two transfer
numbers can also be entered. The user can record a message stating that the caller can press *2 or *3 to transfer
to the specified telephone numbers.

¢ Announcements
IP Office 4.0+ allows Embedded Voicemail to provide announcements to calls waiting to be answered by users. This
is similar to the announcements provided for hunt groups[3™, with announcements being played to callers waiting
to be answered. Due to the overlap of various timeouts, the use of user announcements is not recommended in
conjunction with forwarding and voicemail.

¢ Voicemail Email
IP Office 4.2+. A user can have notification of new messages sent to your their address. The notification can be a
simple alert to tell them that they have a new message or the voicemail message can be sent if required. See
Voicemail Email Integration[ 23

WARNING: Changing User Names

Mailboxes are created based on each user's unique user name within the IP Office configuration. Changing a user name
will associate that user with a new mailbox. If you need to change a user name, ensure that the user has played and
deleted all messages first. If a user name is changed without clearing the original mailbox, you must create a short code
based on the old user name in order to access the old mailbox.
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User Mailbox Configuration:

To change voicemail configuration for an individual:

Al symbol indicates that the setting can also be set and locked through user rights. For details refer to the IP Office
Manager documentation.

1.Open IP Office Manager and receive the IP Office configuration.

2.In the Navigation pane click % User and select the individual user.
3.View the Voicemail tab.

Menu Programming || Mobility || Phone Manager Options || Hunt Group Membership | Announcements | Personal Directory

User | Woicemal | pMD | ShortCodes | Source Mumbers | Telephony | Forwarding | Dial In || Yoice Recording | Button Programming

Voicemail Code Voicemail On
Confirm Yoicemail Code [ waicemail Help
woicemail Emnail [ woicemail Ringback

Voicemail Email Reading

CIFF Copy Forward Alert [] ums web services

DTMF Breakout
Reception | Breakout (DTMF 07 | Systemn Default ()

Breakout (DTMF 2} Syskerm Defaulk )

Breakout (DTMF 3} Syskerm Defaulk )

* Voicemail Code: Default = Blank, Range = 0 (no code) to 15 digits.
A code (1-15 digits) used to validate access to the mailbox. If remote access is attempted to a mailbox that
has no voicemail code set, the prompt "Remote access is not configured on this mailbox" is played.

e The mailbox user can change the code by dialing *04 after having entered the mailbox.

e Voicemail On Default = On
When on, the mailbox is used by the IP Office to answer the user's unanswered calls or calls when the user's extension
would have otherwise returned busy. Note that selecting off does not disable use of the user's mailbox. Messages can
still be forward to their mailbox. The mailbox can also still be accessed to collect messages.

e Voicemail Help Default = Off
This setting is not used for embedded voicemail. Help can be accessed by dialing *4 after accessing the mailbox.

o Voicemail Ringback: Default = Off 2
When enabled and a new message has been received, the voicemail server calls the user's extension to
attempt to deliver the message each time the telephone is put down. Voicemail will not ring the extension more
than once every 30 seconds.

e Voicemail Email Reading: Default = Off
This setting is not used for embedded voicemail.

¢ UMS Web Services: Default = Off, Software level = 4.2+.
This setting is not used for embedded voicemail.

e Voicemail Email: Default = Blank (No voicemail email features)
This field is used to set the user or group email address used for voicemail email operationl23>. When an address is
entered, the additional Voicemail Email controls below are selectable.

e Voicemail Email Default = Off
If an email address is entered for the user or group, the following options become selectable. These control the mode of
automatic voicemail email operation provided by the voicemail server whenever the voicemail mailbox receives a new
voicemail message.

o Off
If off, none of the options below are used for automatic voicemail email. Users can also select this mode by dialing
*03 from their extension.

» Copy
If this mode is selected, each time a new voicemail message is received in the voicemail mailbox, a copy of the
message is attached to an email and sent to the email address. There is no mailbox synchronization between the
email and voicemail mailboxes. For example reading and deletion of the email message does not affect the
message in the voicemail mailbox or the message waiting indication provided for that new message.
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e Forward
If this mode is selected, each time a new voicemail message is received in the voicemail mailbox, that message is
attached to an email and sent to the email address. No copy of the voicemail message is retained in the voicemail
mailbox and their is no message waiting indication. As with Copy, their is no mailbox synchronization between the
email and voicemail mailboxes. Users can also select this mode by dialing *01 from their extension.

o Alert
If this mode is selected, each time a new voicemail message is received in the voicemail mailbox, a simple email
message is sent to the email address. This is an email message announcing details of the voicemail message but
with no copy of the voicemail message attached. Users can also select this mode by dialing *02 from their
extension.

o DTMF Breakout
When a caller is directed to voicemail to leave a message, they can be given the option to be transferred to a
different extension. The mailbox greeting message needs to be recorded telling the caller the options available.
The extension numbers that they can be transferred to are entered in the fields below.

e For IP Office 5.0+, system default values can be set for these numbers and are used unless a different
number is set within these user settings. Also for IP Office 5.0+, these values can be set using User
Rights.

e Reception / Breakout (DTMF 0)
The number to which a caller is transferred if they press *0 while listening to the mailbox greeting rather than
leaving a message.

¢ Breakout (DTMF 2)
The number to which a caller is transferred if they press *2 while listening to the mailbox greeting rather than
leaving a message.

e Breakout (DTMF 3)
The number to which a caller is transferred if they press *3 while listening to the mailbox greeting rather than

leaving a message.
4.Click OK to save the voicemail changes for the user.

5.Amend any other user details, then save and merge the configuration changes.

Embedded Voicemail Installation Page 22
IP Office Release 8.0 15-601067 Issue 12d (21 February 2012)



User Mailbox Configuration:

3.1 Voicemail Email Integration

Voicemail Email features with Embedded Voicemail is supported. This uses the IP Office system's SMTP settings to send
messages to the customer's email server. That server then forwards those messages into the user email mailboxes.

Once enabled, users can select to have a email alert about each new voicemail message or to have the voicemail message
forwarded to their email mailbox. In addition when listening to a message in their voicemail mailbox they can forward it to
their email mailbox.

¢ Warning
The sending of .wav files across a network creates a high loading on the network and networks servers. A one-
minute message requires a 1MB .wav file.

1. Note that changing the IP Office's SMTP settings requires the system to be restarted.

2.0btain details of the customer's SMTP email server. You can configure a user account on that server in order for it
to accept and relay emails from the IP Office.

3.Using IP Office Manager, receive the IP Office system configuration.
4. Select System and then the SMTP tab.
5. Enter the details to match the customer SMTP server.

o IP Address
The IP address of the customer's SMTP server. If not on the same subnet as the IP Office LAN, an IP route
must also be added.

e Port
The SMTP listening port of the server. The default is 25.

e« Email From Address
This is the address that will be used by the IP Office. Some servers will only relay messages from recognized
full addresses or addresses in the same domain.

e Server Requires Authentication
If the server requires a user account to receive and send emails, enter the details of an account configured on
that server for use by the IP Office.

6. For each user, select User | Voicemail.
7.1n the Voicemail Email field enter the user's email address.
8.Using the radio button, select the type of Voicemail Email function alerts for the user.

o Off
Don't send email alerts for new messages. Users can select this themselves by dialing *03.

e Copy
Send a copy of each new message received to the user's email address. User's cannot select this mode
themselves.

e Forward
Forward each new message received to the user's email address, deleting the message from their mailbox.
Users can select this themselves by dialing *01.

e Alert
Send an email alert for each new message received. Users can select this themselves by dialing *02.

9.Send the configuration back to the IP Office.
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3.2 User Announcements

Announcements are played to callers waiting to be answered. This includes callers being presented to hunt group
members, ie. ringing, and callers queued for presentation.

IP Office 4.0+ supports announcements using Embedded Voicemail.
If no voicemail channel is available for an announcement, the announcement is not played.
Calls can be answered during the announcement.

If a call is rerouted to a hunt group's Night Service Group or Out of Service Fallback Group, the announcements of
the new group are applied.

If a call overflows, the announcements of the original group are still applied, not those of the overflow group.

For announcements to be used effectively, the hunt group's Voicemail Answer Time must be extended or
Voicemail On must be unselected.

Announcement Configuration
1.Open IP Office Manager.

2.Select the user or hunt group for which announcements are required.

3.View the Announcements tab.

Announcements |

_|7 Announcements Oon

Wait before 1st announcement (seconds) |1 5: ™ synchronise Calls
Flag call a5 answered -

1

| Play 1st announcement

Post announcement tone IMusiu: an hold j
Znd Announcemenk v

W'ait before 2nd announcement - -

(seconds) z

|

[Play 2nd announcement —

!

Repeat last announcement v

|

W ait before repeat (seconds) 20 -

¢ Announcements On: Default = Off.
This setting enables or disables announcements.

o Wait before 1st announcement: Default = 10 seconds. Range = 0 to 9999 seconds.
This setting sets the time delay from the calls presentation, after which the first announcement should be
played to the caller. If Synchronize Calls is selected, the actual wait may differ, see below.

+ Flag call as answered: Default = Off.
This setting is used by the IP Office CCC and CBC applications. By default they do not regarded a call as
answered until it has been answered by a person. This setting allows calls to be marked as answered once the
caller has heard the first announcement. This setting is not used by the IP Office Customer Call Reporter
application.

¢ Post announcement tone: Default = Music on hold.
Following the first announcement, you can select whether the caller should hear Music on Hold, Ringing or
Silence until answered or played another announcement.

¢ 2nd Announcement: Default = On.
If selected, a second announcement can be played to the caller if they have still not been answered.
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User Mailbox Configuration: User Announcements

¢ Wait before 2nd announcement: Default = 20 seconds. Range = 0 to 9999 seconds.
This setting sets the wait between the 1st and the 2nd announcement. If Synchronize Calls is selected, the
actual wait may differ, see below.

e Repeat last announcement: Default = On.
If selected, the last announcement played to the caller is repeated until they are answered or hang-up.

o Wait before repeat: Default = 20 seconds. Range = 0 to 9999 seconds.
If Repeat last announcement is selected, this setting sets is applied between each repeat of the last
announcement. If Synchronize Calls is selected, this value is grayed out and set to match the Wait before
2nd announcement setting.

¢ Synchronize calls: Default = Off
This option can be used to restrict how many voicemail channels are required to provide the announcements.

o Off
When Synchronize calls is off, announcement are played individually for each call. This requires a
separate voicemail channel each time an announcement is played to each caller. While this ensures
accurate following of the wait settings selected, it does not make efficient use of voicemail channels.

e On
When Synchronize calls is on, if a required announcement is already being played to another caller,
further callers wait until the announcement been completed and can be restarted. In addition, when a
caller has waited for the set wait period and the announcement is started, any other callers waiting for the
same announcement hear it even if they have not waited for the wait period. Using this setting, the
maximum number of voicemail channels ever needed is 1 or 2 depending on the number of selected
announcements.

4. Click OK to save the changes.

5.Click |.'E‘ to merge the configuration back to the IP Office.

Recording the Announcements
There are no default queue announcements for user and hunt groups. The maximum length for announcements is 10
minutes.

On new IP Office 4.0+ systems there are two default short codes that enable you to record announcements. On existing
and upgraded systems these or similar short codes need to be added manually.

The default short codes are:

e *91N; / N".1" / Record Message
Used to record an announcement 1. For example, to record announcement 1 for a hunt group on extension 300
dial ¥*91300# and follow the instructions to record the new announcement.

e *¥92N; / N".2" / Record Message
Used to record an announcement 2. For example, to record announcement 2 for a hunt group on extension 300
dial ¥*92300# and follow the instructions to record the announcement.
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4. Hunt Group Mailbox Configuration

Embedded Voicemail creates a mailbox for each hunt group on the IP Office system. Calls are sent to the mailbox only
when each available group member has been rung for the group's set ring time.

The group mailbox can be configured either through the mailbox (refer to the Embedded Voicemail User Guide) or through
the hunt group settings in the IP Office Manager.

¢ Message Waiting Indication
By default there is no message waiting indication to any user for hunt group messages. Users must be configured
individually. For more information, see Message Waiting Indication 29,

¢ Mailbox Access
By default there is no mailbox access to hunt group mailboxes to collect messages. Users assigned hunt group
message waiting indication can also gain access depending on their phone type or if using IP Office Phone Manager.
Otherw’i%%an access short code must be created for the hunt group. For more information, see Hunt Group Mailbox
Access| 307,

¢ Ringback
Embedded Voicemail can be set to ring the user whenever they have new messages in a hunt group mailbox for
which they receive message waiting indication. This ringback is triggered the completion of a call at the user's
extension.

¢ Voicemail On/Off
The sending of calls to the group's mailbox can be switched off. Note however that this does not stop other
methods of leaving messages directly in the mailbox.

¢ Access Code
An access code can be assigned to the mailbox. Anyone accessing the mailbox must first enter this code before
they can collect messages. The access code can be reset by the user once they are in the mailbox.

WARNING: Changing Hunt Group Names

Mailboxes are created based on the unique group name within the IP Office configuration. Changing a group name will
associate that group with a new mailbox. If you need to change a group name, ensure that they have played and deleted
all messages first. If a group name is changed without clearing the original mailbox, you must create a short code based
on the old group name in order to access the old mailbox.

The group mailbox can be configured either through the mailbox and system short codes or through the hunt group
settings within the IP Office configuration.

To configure a group mailbox in IP Office Manager:
1.Open IP Office Manager and receive the IP Office configuration.

2.Click % Hunt Group to display the list of existing hunt groups.
3. Double-click the required hunt group.

4. Click the Voicemail tab. This tab includes settings that are used by IP Office Voicemail Lite and Voicemail Pro. For
Embedded Voicemail complete the following details:

¢ Voicemail Code
This field can be used to set a mailbox access code. That code must then be entered by anyone attempting to
retrieve messages from the mailbox.

e Voicemail On
When ticked, calls to the hunt group's number will divert to voicemail if all available group members are busy
or do not answer within the group's set allocated answer interval.

5.Make any changes as required for the hunt group and click OK.

6.Repeat for any other hunt group.

7.Use |.'E‘ to save the new changes back to the IP Office system.
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Hunt Group Mailbox Configuration:

4.1 Message Waiting Indication

By default no message waiting indication is sent to any user for a hunt group mailbox. The following process shows how to
give a user message waiting indication from a hunt groups mailbox. The method of indication will depend on the type of
telephone the user has and whether they are using IP Office Phone Manager.

1. Start IP Office Manager and receive the IP Office configuration.

. Click % User to display the list of existing users.
.Double-click the user who requires hunt group message waiting indication.
.Click the Source Numbers tab.

.Click Add.

a U A W N

.In the Source Number field, enter H followed by the name of the hunt group. For example, for the hunt group
Main, enter HMain.

N

.Click OK and repeat for any other hunt groups for which the user requires message waiting indication.

8.Click OK and repeat for any other users.

9.Use |.'E‘ to save the new changes back to the IP Office system.
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4.2 Hunt Group Mailbox Access

By default no user has access to a hunt group mailbox until specifically configured for such access. Hunt group mailboxes
can be accessed using the following methods:

Message Waiting Indication

Users who have been assigned hunt group message waiting indication are also given methods to access the hunt group

mailbox. The method will depend on the telephone and/or software they are using. For more information, see Message
Waiting Indication[ 29",

e Avaya 4400 Series Telephone Users
DS display phone users on telephone models with a % MENU key also gain access once they have been
configured for hunt group message waiting. The hunt group name is then displayed when the user presses
MENU, % MENU, Msgs, Voice. For more information, see your telephone user guide.

¢ Phone Manager Users

Phone Manager users see the hunt group name and number of messages listed on the Messages tab. They can click
this to access the hunt group mailbox.

¢ Voicemail Ringback
If a user has voicemail ringback enabled, ringback will occur for new group messages as well as new personal
messages. Ringback for personal messages takes place before any ringback for new group messages.

¢ Visual Voice

If Visual Voice is available, the user will see the name of the hunt group listed. The humber of new calls are shown
in brackets next to the hunt group name.

Short Code and button Access

A short code can be created for hunt group mailbox access, as detailed in the table. This can be a system wide or user
specific short code. For information about setting up short codes, see the IP Office Manager help or guide.

Code *99

Feature Voicemail Collect
Telephone Number "?Sales"

Line Group Id 0

The Voicemail Collect feature and hunt group mailbox name can also be assigned to a user's programmable button.

Remote Access

The standard methods for remote mailbox access apply to users or to hunt groups. For more information, see Remote
Mailbox Access| 46™.
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Hunt Group Mailbox Configuration: Hunt Group Mailbox Access

4.3 Announcements

Announcements are played to callers waiting to be answered. This includes callers being presented to hunt group
members, ie. ringing, and callers queued for presentation.

IP Office 4.0+ supports announcements using Embedded Voicemail.
If no voicemail channel is available for an announcement, the announcement is not played.
Calls can be answered during the announcement.

If a call is rerouted to a hunt group's Night Service Group or Out of Service Fallback Group, the announcements of
the new group are applied.

If a call overflows, the announcements of the original group are still applied, not those of the overflow group.

For announcements to be used effectively, the hunt group's Voicemail Answer Time must be extended or
Voicemail On must be unselected.

Announcement Configuration
1.Open IP Office Manager.

2.Select the user or hunt group for which announcements are required.

3.View the Announcements tab.

Announcements |

_|7 Announcements Oon

Wait before 1st announcement (seconds) |1 5: ™ synchronise Calls
Flag call a5 answered -

1

| Play 1st announcement

Post announcement tone IMusiu: an hold j
Znd Announcemenk v

W'ait before 2nd announcement - -

(seconds) z

|

[Play 2nd announcement —

!

Repeat last announcement v

|

W ait before repeat (seconds) 20 -

¢ Announcements On: Default = Off.
This setting enables or disables announcements.

o Wait before 1st announcement: Default = 10 seconds. Range = 0 to 9999 seconds.
This setting sets the time delay from the calls presentation, after which the first announcement should be
played to the caller. If Synchronize Calls is selected, the actual wait may differ, see below.

+ Flag call as answered: Default = Off.
This setting is used by the IP Office CCC and CBC applications. By default they do not regarded a call as
answered until it has been answered by a person. This setting allows calls to be marked as answered once the
caller has heard the first announcement. This setting is not used by the IP Office Customer Call Reporter
application.

¢ Post announcement tone: Default = Music on hold.
Following the first announcement, you can select whether the caller should hear Music on Hold, Ringing or
Silence until answered or played another announcement.

¢ 2nd Announcement: Default = On.
If selected, a second announcement can be played to the caller if they have still not been answered.
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¢ Wait before 2nd announcement: Default = 20 seconds. Range = 0 to 9999 seconds.
This setting sets the wait between the 1st and the 2nd announcement. If Synchronize Calls is selected, the
actual wait may differ, see below.

e Repeat last announcement: Default = On.
If selected, the last announcement played to the caller is repeated until they are answered or hang-up.

o Wait before repeat: Default = 20 seconds. Range = 0 to 9999 seconds.
If Repeat last announcement is selected, this setting sets is applied between each repeat of the last
announcement. If Synchronize Calls is selected, this value is grayed out and set to match the Wait before
2nd announcement setting.

¢ Synchronize calls: Default = Off
This option can be used to restrict how many voicemail channels are required to provide the announcements.

o Off
When Synchronize calls is off, announcement are played individually for each call. This requires a
separate voicemail channel each time an announcement is played to each caller. While this ensures
accurate following of the wait settings selected, it does not make efficient use of voicemail channels.

e On
When Synchronize calls is on, if a required announcement is already being played to another caller,
further callers wait until the announcement been completed and can be restarted. In addition, when a
caller has waited for the set wait period and the announcement is started, any other callers waiting for the
same announcement hear it even if they have not waited for the wait period. Using this setting, the
maximum number of voicemail channels ever needed is 1 or 2 depending on the number of selected
announcements.

4. Click OK to save the changes.

5.Click |.'E‘ to merge the configuration back to the IP Office.

Recording the Announcements
There are no default queue announcements for user and hunt groups. The maximum length for announcements is 10
minutes.

On new IP Office 4.0+ systems there are two default short codes that enable you to record announcements. On existing
and upgraded systems these or similar short codes need to be added manually.

The default short codes are:

e *91N; / N".1" / Record Message
Used to record an announcement 1. For example, to record announcement 1 for a hunt group on extension 300
dial ¥*91300# and follow the instructions to record the new announcement.

e *¥92N; / N".2" / Record Message
Used to record an announcement 2. For example, to record announcement 2 for a hunt group on extension 300
dial ¥*92300# and follow the instructions to record the announcement.
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Chapter 5.
Auto Attendant Configuration
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5. Auto Attendant Configuration

In addition to basic voicemail operation, you can create auto attendants using Embedded Voicemail. For IP Office 4.1+, up
to 40 auto attendant services are supported whereas previously only 4 were supported.

Each auto attendant consists of:

e Actions
Each of the normal DTMF dialing keys; *, # and 0 to 9, can be assigned to an action. Callers can dial-through
prompts, that is press an action key while listening to the greetings prompts. For IP Office 4.0+, you can also
assign an action to the key Fax. If a transfer action is set, on detecting fax tone the auto attendant will route the
call to the fax transfer destination as specified using the Transfer action.

+ Dial by Name IP Office 5.0+
Callers can dial the name of the user they require. A list of matching names is then played to them to make a
selection.

e Dial by Number
Callers can dial the required extension number. There is no prompt associated with the action. If a prompt is
required it as part of the menu prompt. Unexpected results can occur if the dial plan is not a uniform length.
Hunt group and user extension numbers should all be the same length.

¢ Normal Transfer
Transfers the caller to a specified number. This is a supervised transfer, that is, if busy or unanswered the call
will follow the settings of the target user or hunt group. If the destination field is left blank, callers can dial the
extension number that they require, however no prompts will be played.

¢ Not Defined
Take no action.

 Replay Greeting
Repeat the menu greeting.

e Transfer
Callers are transferred to the selected destination. This action is used with the key Fax so that when a fax tone
is detected the call is transferred to the specified extension.

e Transfer to Attendant
Used to access one auto attendant from another.

e Prompts
You can record separate morning, afternoon and evening (out of hours) greeting prompts. Which prompt is used is
defined by associated Time Profiles. The greeting prompt is followed by a menu options prompt. This is used to
inform the caller of the auto attendant options. For more information, see Recording Prompts| 37

e In situations where time profiles are absent, overlap or conflict; the order of precedence given is to time
profiles assigned to Morning, Afternoon and then Evening.
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Auto Attendant Configuration:

5.1 Create an Auto Attendant

The following process shows by example the setup for an auto attendant for Embedded Voicemail. In this example the
auto-attendant should give callers the option to press 0 for reception (hunt group 200) or 1 for sales (hunt group 301).

e For details of routing calls to the auto attendant, see Routing Incoming Calls to an Auto Attendant/ 38,

To create an auto attendant:
1. Start IP Office Manager and load the required configuration.

2. Note that if time profiles are going to be used in an auto attendant, the time profile has to be created before creating
the auto attendant. For more information, see the IP Office Manager help.
3.Click ﬁ Auto Attendant. Any existing Auto Attendants are listed.

4.Click Create a New Record in the Group Pane. Select Auto Attendant.In the Name field enter the name for the auto
attendant. This can be up to 15 characters in length.

Auko Atkendant | Ackions

Auto Akkendant Configuration

Marme <Auto Atten: 0 Enable Local Recording
Mazirurn Inackiviky g -
A Murmber 01
Cirect Dial-By-Murnber ]
Dial By Mame Match Order | Last then First w
Time Profile Recording Mame Shortcode
Marning <Mone = w | | <=Maone= w
Afternoon <Mone= W | | <Mone= L
Ewvening <MNone= w | | <Mone > w
Menu Options <MNone = W

e Name: Range = Up to 12 characters
This field sets the name for the auto-attendant service. External calls can be routed to the auto attendant by
entering AA:Name in the destination field of an Incoming Call Route.

¢ Maximum Inactivity: Default = 8 seconds; Range = 1 to 20 seconds, Software level = 3.0+.
This field sets how long after playing the prompts the Auto Attendant should wait for a valid key press. If exceeded,
the caller is either transferred to the Fallback Extension set within the Incoming Call Route used for their call or else
the caller is disconnected.

e Enable Local Recording: Default = On, Software level = 4.0+ (Q2 2007 Maintenance release).
When off, use of short codes to record auto-attendant prompts is blocked. The short codes can still be used to
playback the greetings.

o Direct Dial-By-Number: Default = Off, Software level = 6.0+.
This setting affects the operation of any key presses in the auto attendant menu set to use the Dial By Number
action.

o If selected, the key press for the action is included in any following digits dialed by the caller for IP Office
extension matching. For example, if 2 is set in the actions to Dial by Number, a caller can dial 201 for
extension 201.

e If not selected, the key press for the action is not included in any following digits dialed by the caller for IP
Office extension matching. For example, if 2 is set in the actions to Dial by Number, a caller must dial 2 and
then 201 for extension 201.

« Dial by Name Match Order: Default = First Name/Last Name, Software level = 5.0+.
Determines the name order used for the the Embedded Voicemail Dial by Name function. The options are First
then Last or Last then First.

e AA Number: Software level = 4.1+.
This number is assigned by the IP Office and cannot be changed. It is used in conjunction with short codes to
access the auto attendant service or to record auto attendant greetings.
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¢ Morning/Afternoon/Evening/Menu Options:
Each auto-attendant can consist of three distinct time periods, defined by associated time profiles. A greeting can
be recorded for each period. The appropriate greeting is played to callers and followed by the Menu Options
greeting which should list the available actions.

e Time Profile
The time profile that defines each period of auto-attendant operation. When there are overlaps or gaps
between time profiles, precedence is given in the order morning, afternoon and then evening.

e Short code
These fields indicate the system short codes automatically created to allow recording of the time profile
greetings and the menu options prompt.

e Recording Name: Default = Blank. Range = Up to 31 characters, Software level = 4.0+ (Q2 2007
Maintenance release).
This field appears next to the short code used for manually recording auto-attendant prompts. It is only used is
using pre-recorded wav files as greeting rather than manually recording greetings using the indicated short
codes. If used, note that the field is case sensitive and uses the name embedded within the wav file file header
rather than the actual file name.The utility for converting .wav files to the correct format is provided with
Manager and can be launched via File | Advanced | LVM Greeting Utility [ 42\, Files then need to be manually
transferred to the embedded voicemail memory card.

5.Click the Actions tab. The option to press 0 for reception (hunt group Main) is entered by:
e Click with the Key 0 row. Click Edit.

e Select the action Normal Transfer from the available options.

 Select the required destination. In this example the group Main is selected.

e Click OK.
&uto Atkendant | Actions

Key | Ackion Destination

Mormal T...  Main
Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined

H ¥ 00 R MO

-
1]
=

6.The option to press 1 for sales (hunt group 301) is entered by:
e Click within the Key 1 row. Click Edit.
e Select the action Normal Transfer from the available options.
 Select the required destination, for this example the group Sales.
e Click OK.

7.Click OK to save the auto attendant. Short codes are automatically created for the auto attendant and the codes can be
viewed in the Auto Attendant tab.

8. Click Cﬂ to save the new changes back to the IP Office system.

9. Following the system reboot, you can record prompts for the auto attendant using the short codes created. For more
information, see Recording Prompts/ 37
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Auto Attendant Configuration: Create an Auto Attendant

5.2 Recording Prompts

When a new auto attendant is created, a number of short codes are automatically added to the system short codes table.
The short codes allow the recording of the various auto attendant prompts. The appropriate number to dial is indicated
against each greeting on the Auto Attendant tab in IP Office Manager.

The telephone number part takes the form "AA:Name.x", where Name is the name of the auto attendant service, and x
is 1 for the morning greeting, 2 for the afternoon greeting, 3 for the evening greeting and 4 for the menu options prompt.

For IP Office 4.1+ the number can also take the form "AA:"N".x" where N is the auto attendant number and x is 1 for
the morning greeting, 2 for the afternoon greeting, 3 for the evening greeting and 4 for the menu options prompt.

When using any of these short codes, you hear the options:
e 1 to hear the current prompt.
e 2 to record a new prompt.

e 3 to save the new prompt.

Notes

e To prevent abuse of these default short codes, they can be deleted or changed. They can also be removed from the
system short codes section and rebuilt in the user short codes of a trusted user. Alternately, disabling the Enabling
Local Recording option (IP Office 4.0 May 2007 maintenance release and higher) stops the use of short codes to
record the auto attendant greetings.

e Using the Dial feature, the short codes can be assigned to a programmable button. This allows quick access and
recording of any prompts that change frequently.
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5.3 Routing Incoming Calls to an Auto Attendant

An integral voicemail auto attendant created can be specified as a destination in the IP Office Incoming Call Routes table.
Internal callers can access an auto attendant through a programmed DSS button or Phone Manager speed dial.

To route incoming calls to an auto attendant:
1. Start IP Office Manager and load the required configuration.

2.Click ‘b Incoming Call Route and select the required route.

3.View the Standard tab. Check that the settings match the calls you expect to be routed to the auto attendant (for
full details refer to the IP Office Manager documentation).

4.Click the Destination tab. In the Destination field use the drop down list to select the auto attendant. The names
of the configured auto attendants are shown prefixed with AA:.

Standard | Voice Recording | Destinations

TimeProfile Destination Fallback Extension

» Default Yalue A Exarmple 200 Main

5.In the example above the Fallback Extension has also been set to route calls to a hunt group. The Fallback
Extension setting is used for callers in the auto attendant who do not make a valid key press within the auto
attendant's Maximum Inactivity time.

6.Using time profiles, additional destination sets can be added to use the auto attendant at certain times of day or to
use different auto attendants at different times.

7.Click OK.

8.Use H to save the new changes back to the IP Office system.
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Auto Attendant Configuration: Routing Incoming Calls to an Auto Attendant

5.4 Transferring Calls to an Attendant

Normally calls are directed to an auto attendant by an IP Office incoming call route. However it can also be useful to
transfer calls received at an internal extension to an auto attendant.

You can transfer calls to an Auto Attendant by:

e Using Programmed Buttons/ 39,

e Using Phone Manager!3d.

e Using SoftConsole[ 40,

e Using Short Codes|4d.

Using Programmed Buttons
On Avaya phones with programmable buttons, those buttons can be programmed to access auto attendant services.

To create an auto attendant button:
1.From the IP Office system configuration, set the action of one of the users programmable buttons to Dial.
2.Set the associated telephone number to AA:Name where Name matches the name of the auto attendant.

3.Save this configuration change back to the IP Office.

When the user receives a call they want to transfer to the auto-attendant, they can use a programmed button.
To transfer a call using the programmed button:

1.Place the call on hold.

2.Press the button programmed for the auto-attendant.

3.Hang-up the call at their extension. This will cause a blind transfer of the held call to the auto-attendant.

Using Phone Manager
To create an auto attendant speed dial:

1. Within the user's Phone Manager, click the Speed Dials tab.

2.Right-click the speed dial panel and select New > Speed Dial Group Member. The Speed Dial window opens.
3.In the Name field, enter a name for the Auto Attendant.

4.In the Number field, enter AA:Name where Name matches the name of the auto attendant.

5.Click OK.

To transfer a call using the Speed Dial:

1.During a call that you want to transfer to the auto attendant click E Hold to place the call on hold.
2.Click the Speed Dials tab.

3. Click the speed dial created for the auto attendant.

4. Click (v( Complete Transfer to transfer the held caller.
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Using SoftConsole
To create an auto attendant speed dial:

1. Click the required BLF Group tab.

2. Right-click the speed dial panel and select New > BLF Group Member. The New BLF Group Member window
opens.

3.In the Name field, enter a name for the Auto Attendant.
4.In the Number field, enter AA:Name where Name matches the name of the auto attendant.

5.Click OK.

To transfer a call using the Speed Dial:
1.During a call that you want to transfer to the auto attendant click E Hold to place the call on hold.

2.Click the BLF Group tab.
3.Click the speed dial created for the auto attendant.

4. Click (v( Complete Transfer to transfer the held caller.

Using Short Codes

The Auto Attendant short code feature can be used to connect to a particular auto attendant. The Telephone Number
field takes the form AA: followed by the Auto Attendant service name.

In the example below, dialing *¥*98 would connect the user with the auto attendant named Example.

Code *98

Feature Auto Attendant
Telephone Number "AA:Example"
Line Group Id 0

Once a short code for a particular auto attendant has been created, callers can be transferred.

To transfer a caller:
1.Press TRANSFER.
2.Dial the auto attendant short code.

3.Press TRANSFER again to complete the process.
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Auto Attendant Configuration: Transferring Calls to an Attendant

5.5 Using Auto Attendant to Access Voicemail

A useful function in auto attendants is to let callers access their own voicemail mailbox. This can be achieved by first
creating a short code and then using the short code as an auto attendant destination.

To create a short code for remote access:
1. Start IP Office Manager and load the required configuration.

2. For the user or hunt group for which you want to create remote access, open their settings and on the Voicemail
tab ensure that a Voicemail Code has been set. Remote access will not work without this.

3.1In the configuration tree panel, click 9” Shortcode. Any existing system short codes are listed.
4.Click Create a New Record in the Group Pane. Select Short Code.

5.Create a short code such as the following example:

Code *99

Feature Voicemail Collect
Telephone Number ?

Line Group Id 0

6.Click OK to add the new short code.

7.Create an auto attendant and select the key that the caller should use. Set the keys Action to Normal Transfer.
Type the short code in the destination, in the example it would be *99.

8.Click OK.

9. Click |.'E‘ to save the new changes back to the IP Office system.

External callers to the auto-attendant selecting the right option will now be challenged to enter the mailbox number and
then the mailbox access code. If entered correctly they will be able to collect messages.

Embedded Voicemail Installation Page 41
IP Office Release 8.0 15-601067 Issue 12d (21 February 2012)



5.6 Using Named Announcement Files

IP Office 4.1+ allows pre-recorded files to be converted and used as auto attendant greetings. This approach allows
greetings to be recorded by methods other than through the IP Office phone short codes. It also allows the same greeting
to be shared by several auto attendants.

¢ Preventing Over Recording of Uploaded Files
Once uploaded to the IP Office, the converted files can still be recorded over using the default short codes for
recording auto attendant greetings. To prevent this use de-select the Enable Local Recording option of the auto
attendant.

A. Converting the Recordings
This process converts the source WAV file recording to the format required by the IP Office Embedded Voicemail.

1.The original recording must be in the following WAV file format. If it is in a different format, convert the file using a
tool such as Windows Sound Recorder.

¢ PCM/Uncompressed.
e 8000 KHz, 16bit, Mono.
2.Start IP Office Manager.
3.Select File | Advanced | LVM Greeting Utility.

U LVM Greeting Utility EEIX
Output File I,

Recording Hame

s G?‘l‘ly

Cancel

4.Click on the ... button for Input File and select the WAV file.
5.Click on the ... button for Output File and select the location into which you want the converted file saved.
6.Select the Format G711.

e Enter a name for the file (up to 8 characters with no spaces) and end the file name with .c11.

e Enter a name for the recording in the Recording Name field. This is the name that will be entered into the IP
Office configuration to use the recording. Note that the field in case sensitive.

7.Ensure that the Format matches that selected for the Output File settings chosen above.

8.Click OK.

B. Editing an Auto Attendant to Use Named Recordings
1. Start IP Office Manager and receive the IP Office configuration.

2.Select the ﬁ Auto Attendant form and select or create the required auto attendant.

3.In the Recording Name field enter the name of the greeting to be used. This is the Recording Name entered
during the files conversion, not the actual file name. It is case sensitive.

4.If only converted greeting files are to be used with the auto attendant, you can disable the Enable Local
Recording option to stop any system user recording over the file.

5.Send the configuration back to the IP Office.

C. Transferring the Recording to the Embedded Voicemail Memory Card

Using IP Office Manager, select File | Advanced | Embedded File Management. Drag and drop the recording created
above into appropriate folder on the memory card. For IP500v2 systems this is dynamic\lvmail\AAG folder on the
System SD card, for other systems it is the Ivmail\AAG folder.
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Auto Attendant Configuration: Using Named Announcement Files

5.7 Dial by Name

IP Office 5.0 allows the option Dial by Name to be selected as an auto attendant option. Callers selecting this option are
asked to dial the name they require and then press #. The recording name prompts of matching users are then used to
allow the caller to make their selection.

The name order used for set to first name/last name or last name/first name by the Dial by Name Match Order/ 353
setting on the Auto Attendants settings.

The name used for matching is taken from the user's configuration within the IP Office configuration. The Full Name is
used if set, otherwise the Name is used.

Users are exclude from Dial by Name if they:
e Are marked as Ex Directory (User | User) in the IP Office configuration.
e Do not have a recorded mailbox name prompt.

e They can record their own name by dialing *05 after accessing their mailbox.

e The function assumes that a standard ITU lettered dialing pad is being used.

FREDES
Falrave
[PG;ES][TEV][WKBYEJ
Ty e

e The action prompts the caller to dial the name they require and then press #. For example, dialing 527 matches
names starting with JAS (for example "Jason") and KAR (for example "Karl"). Callers can also press *# to exit
without making a selection.

e If no matches are found, the caller is given the option to retry.

e If 10 or less matches are found, the matching mailbox name greetings are played as part of a selection list, i.
e. "Press 1 for ..., press 2 for ..., ...".

e If more then 10 matches are found, the caller is prompted to either press # to hear the first 10 or to dial more
characters to reduce the number of matches. If they select to play the list, after each set of 10 matches they
can either make a selection or follow the prompts for other options.

Embedded Voicemail Installation Page 43
IP Office Release 8.0 15-601067 Issue 12d (21 February 2012)






Chapter 6.
Miscellaneous
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6. Miscellaneous
6.1 Remote Mailbox Access

Remote mailbox access is accessing a mailbox from any location does not match the mailbox user or hunt group's number.
That includes both internal and external access.

e Remote access is only possible if the mailbox user or hunt group has a voicemail code set in the IP Office
configuration.

There are a number of ways to enable remote mailbox access.

1.Direct from an Incoming Call Route
An incoming call route could be configured to enable remote access to a mailbox. The option Voicemail can be
selected as the Destination and/or Night Service Destination of an Incoming Call Route.

2.Using a Short Code
A short code can be created that uses the Voicemail Collect feature but without a mailbox name specified in the
Telephone Number field will trigger remote access. An example is shown below. This short code could be utilized
by users on the system, as the destination in an Incoming Call Route or as the destination for a auto attendant

option.
Code *99
Feature Voicemail Collect
Telephone Number ?
Line Group Id 0

3.Via an Auto Attendant
An auto attendant can be used to enable remote access to a mailbox. A short code similar to the example could be
entered as the Destination for one of the auto attendant Normal Transfer key options. For more information, see
Using Auto Attendant to Access Voicemail [ 41,
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Miscellaneous: Remote Mailbox Access

6.2 Monitoring Embedded Voicemail

The IP Office Monitor application can be used to observe the operation of Embedded Voicemail.

1.From the Start menu select Programs > IP Office.

2.Select E‘ Monitor.
3.From the File menu, click Select Unit. The Select System to Monitor window opens.

4.Enter the Control Unit IP Address and password. Depending on the IP Office system's configuration, the
password required is either the system password or the separate monitor password if set.

5.Check that the Control Unit Type is set to IP Office.
6.Click OK.

7.The Monitor application attempts to connect with the control unit. If successful, something similar to the following
will appear.

FRxdkkkkkk contact made with 192.168.42.119 at 10:08:25 15/11/2006 ******iiix
FrxAAFIxxx System (192.168.42.119) has been up and running for lday, 19hrs, 3mins and 7secs(154987775mS) **-
154987776mS PRN: Monitor Started 1P=192.168.42.130 IP 500 4.0(11031) 1P500_40
(1P Office: Supports Unicode, System Locale is eng)
154987776mS PRN: LAW=A PRI1=0, BRI=4, ALOG=4, ADSL=0 VCOMP=32, MDM=0, WAN=0, MODU=0 LANM=0 CkSRC=1 VMAIL=1(\
154987778mS LIST2: IFACE(4) '"LAN1","LAN2","Dialln","RemoteManager"
A:\Ivmai INENG\*_*
155088356mS PRN: LVM Flash A: NextFlashltemScan: Scanning A:\lvmailI\ITA\*_*
155088456mS PRN: LVM Flash A: NextFlashltemScan: Finished Scanning A:\lvmaiI\ITA\*_*
155088462mS PRN: LVM Flash A: NextFlashltemScan: Finished Scanning A:\lvmail\*_*
155088462mS PRN: LVM Flash A: NextFlashltemScan: END-OF-LIST found
155088462mS PRN: LVM FlashMan: FiveMinuteActions: called 2006/11/15 10:10:02
155088520mS PRN: LVM FlashMan: FiveMinuteActions: Free: 955.9 MBytes ( 92% )
155088520mS PRN: 33 Hours 11 Minutes Approx. Remaining
155088520mS PRN: FMML Size: 27

8.From the Filters menu select Trace Options. The All Settings window opens.

9.The following Embedded Voicemail events can be selected to be included on the monitor trace:
10.0n the Call tab, select the options that you want to monitor in the Embedded Voicemail section.
11.0n the System tab, select Print.

12.The Trace Color selection on the System tab is applied to Embedded Voicemail events.

13.Click OK.

14.Embedded Voicemail events are now shown in the Monitor trace when running. These events are all prefixed LV.

Embedded Voicemail Housekeeping

The embedded voicemail performs housekeeping approximately every 5 minutes, subject to other system activity. This
can be seen in IP Office System Monitor by enabling the trace option Filters | Call | House Keeping (Embedded
Voicemail).

The details include the approximate remaining message capacity of the memory card.

156165753mS LVM(housekeeping): FlashMan: FiveMinuteActions: called 2009/01/29 06:52:55
156165796mS LVM(housekeeping): FlashMan: FiveMinuteActions: Free: 426.4 MBytes ( 81% )
156165796mS LVM(housekeeping): 14 Hours 48 Minutes Approx. Remaining
156165796mS LVM(housekeeping): FMML Size: 35

Checking the Prompt Sets

The additional embedded voicemail features added in new IP Office releases require new prompts. Missing prompts can be
reported in IP Office System Monitor by enabling the trace options Filters | System | Error. Error messages are output
at regular intervals.

158267586mS ERR: EVM 4p0 upgrade file clips missing
158267587mS ERR: EVM 4p2 upgrade file clips missing
158267592mS ERR: EVM 5pO upgrade file clips missing
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6.3 Button Programming

The same features used for Embedded Voicemail short codes can also be assigned to telephone buttons.

1. Start IP Office Manager and receive the IP Office configuration.

. Click & User to display the list of existing users.
.Click the required user.

.Click the Button Programming tab.

aua ~A W N

.Click the button line that you want to change. Click Edit. The Edit Button fields are shown at the bottom of the
form.

6.Click EI at the end of the Action field. The Button Programming window opens.
7.Select Advanced > Voicemail to display the list of voicemail features.

8.Select the feature required:

* Voicemail Collect
Allows access to a mailbox to collect or leave messages. The mailbox and action are determined by the
associated telephone number. This takes the form "?Name" for message collection and "#Name" for leaving
a message. The Name part must match the user or hunt group name set in the IP Office configuration. On
suitable phones the DSS key displays VMCol followed by the name.

¢ Voicemail On
This feature switches the diversion of calls to the user or group mailbox on/off. When programmed on a DSS
key, the action toggles so no separate Voicemail Off key is required. On suitable phones the DSS key displays
VMOn.

¢ Voicemail Ringback On
This feature switches new message ringback notification on/off. When programmed on a DSS key, the action
toggles so that no separate Voicemail Ringback Off key is required. On suitable phones the DSS key displays
VMRB+.

9. Repeat for all the keys required.
10.Click OK.

11.Repeat for any other users.

12.Use |.'E‘ to save the new changes back to the IP Office system.
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Miscellaneous: Button Programming

6.4 Visual Voice

A user can be given a display menu to user for access to their mailbox. The menu provides the user with options to listen
to messages, send messages, change their greetings and password.

Note
The Visual Voice feature is not available on all telephones. It requires an Avaya phone with multi-line (more than

2 ) display.

MESSAGES Button

For IP Office 4.2+, the MESSAGES button on phones can be configured to activate Visual Voice rather than access
the spoken voicemail prompts. Within IP Office Manager, select System | Voicemail | Messages Button Goes to
Visual Voice.

To give a user a Visual Voice button

1.

Start IP Office Manager and receive the IP Office configuration.

.Click % User to display the list of existing users.
.Click the required user.

.Click the Button Programming tab.

.Click the button line that you want to change.

2
3
4
5
6.
7
8
9

Right-click in the Action field.

.Select Emulation > Visual Voice.
.Click OK to save the button details for the selected user.

.Repeat for any other users.

10.Use L'E‘ to save the new changes back to the IP Office system.
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6.5 Short Codes

Embedded Voicemail supports a number of IP Office short code features.

Default Short Codes
The following default system short codes can be used with Embedded Voicemail.

e Collect Messages: *17
Can be used by users to access the mailbox associated with their extension.

¢ Voicemail On/Off: *18/*19
Switches the diverting of callers to the user's mailbox on/off.

e Voicemail Ringback On/Off: *48/*49
Switches new message ringback to the user on/off.

¢ Record Message:
The Record Message feature is used to record announcements that are used when callers to a hunt group are
queued. For more information, see Configuring Queue Announcements |31,

e *¥91N; - To record an Announcement 1 for a hunt group.

e *¥92N; - To record an Announcement 2 for a hunt group.

Short Code Features

Additional short codes can be added as required using the short code features listed below. For full details of short codes
refer to the IP Office Manager documentation.

¢ Voicemail Collect
This short code feature can be used to create short codes for collecting or leaving messages. The exact action is set
by the use of either ? or # in the telephone number. For example "?Main" would indicate collection of messages in
the mailbox called Main. "#Main" would indicate that a user wants to leave a message in the mailbox called Main.
Note that the quotation marks " " are required and the name must match the user or hunt group whose mailbox is
being accessed. For example:

I

Code *99

Feature Voicemail Collect
Telephone Number "?Main"

Line Group Id 0

e Using just ? in the Telephone Number without quote marks and a mailbox name allows remote access. The
user would be prompted to enter the mailbox number and then the mailboxes access code if set.

¢ Voicemail On/Voicemail Off
These two features switch the diversion of calls to the user or group mailbox on/off. No telephone number is
required for either of these features.

¢ Voicemail Ringback On/Off
These two features switch new message ringback notification on/off. No telephone number is required for either of
these features.

e Auto Attendant
This feature is used for the recording of auto attendant prompts and greetings. Normally the short codes for this
are created automatically. However they can be deleted and reassigned as required. For more information, see
Create an Auto Attendant/ 35>

¢ Record Message
Allows the recording of announcement messages for users and hunt groups.

¢ Shutdown Embedded Voicemail
Supported for IP Office 4.0+. Allows the embedded voicemail service provided by the memory card to be disabled.
For pre-IP Office Release 6 systems, this short code should be used before removing a memory card from the
system. For IP Office Release 6+ systems, a memory card shutdown command should be used instead.

e Startup Embedded Voicemail
Supported for IP Office Release 6+. Allows an embedded voicemail service that has been shutdown to be restarted.
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Performance figures and data quoted in this document are typical, and must be
specifically confirmed in writing by Avaya before they become applicable to any
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